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Advanced Features
Advanced Features 
Your Phaser 7700 Color Printer comes with many useful features to help you create the 
best possible printed documents. You can access the printer features in the printer driver, 
which you use when you send a print job to the printer. To ensure that you have access to 
all of the printer features, make sure that you have installed the printer driver located on 
your Phaser 7700 Printer CD-ROM. Updated printer drivers are also available on the Xerox 
web site: www.xerox.com/officeprinting

Note

You can also set some of the features on the printer’s front panel. The settings in 
the printer driver override the front panel settings.

The following features are described in this manual:

� Print quality mode — see page 2

� TekColor correction — see page 3

� Secure prints, proof prints, and saved prints — see page 4

� Separation pages — see page 6

� Collating copies — see page 6

� N-up (multiple pages on a single sheet of paper) — see page 7

� Booklet printing — see page 7

� Negative and mirror images — see page 8

� Scaling — see page 9

� Watermarks — see page 9

� Image smoothing — see page 10

For additional information on these features, refer to the Windows printer driver’s online 
help.

Refer to the Phaser 7700 Color Printer User Guide for information about two-sided printing 
or printing on the following special media:

� Phaser 7700 Labels

� Phaser 7700 Transparencies

� Envelopes

� Letterhead paper

For information about fonts, refer to page 22.

For information about using color, refer to page 11.
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Advanced Features 
Print quality modes   
You can choose between different print quality modes to obtain the best combination of 
speed and print quality for your job.

*  Approximate number of pages per minute does not include image-processing time. Paper types other than 

Laser Paper or sizes other than Letter/A4 have a lower pages-per-minute speed. Two-sided (duplex) printing 

also has a lower pages-per-minute speed.

You can specify the print quality in a supported driver:

� Windows 95 / Windows 98 PostScript driver:
On the Setup tab, select a print quality by clicking the radio button.

� Windows 2000 / Windows NT PostScript driver:
On the Paper/Quality tab, select a print quality by clicking the radio button.

� LaserWriter 8.6 or 8.7 driver:
In the Print dialog box, select the Print Quality/Color pull-down menu, then select 
the desired mode for Quality.

Print quality mode Maximum speed*

Standard    

� General-purpose mode for color printing

� Produces vibrant, saturated prints with smooth color 
transitions

� Suitable for most office uses and images

� Prints at 1200 x 600 dpi

22 ppm Paper

11 ppm Transparency

Photo   

� Highest-quality color prints

� Richest color and near-photographic detail

� Prints a continuous tone (multiple color densities per pixel) at 
600 x 600 dpi

up to 22 ppm Paper
2 Phaser 7700 Color Printer



Advanced Features
TekColor™ color corrections
You can select a color correction to match particular press specifications or match your 
computer screen’s colors. Otherwise, select Automatic to let the printer automatically pick 
the best color correction for elements in your document.  

You can specify the color correction in a supported driver:

� Windows 95 / Windows 98 PostScript driver: 
On the TekColor tab, select the desired color correction. Some of the color corrections 
are grouped under Office Color and Press Match Color.

� Windows 2000 / Windows NT PostScript driver: 
On the TekColor tab, select the desired color correction. Some of the color corrections 
are grouped under Office Color and Press Match Color.

� LaserWriter 8.6 or 8.7 driver: 
In the Print dialog box, select the Print Quality/Color pull-down menu, then select 
the desired correction for Color.

Color correction Description

Automatic      � Automatically optimizes the color correction for each element (text, 
graphics, and photographs) on the page.

sRGB Display   � Closely approximates the colors on a standard display screen.

sRGB Vivid   � Produces the brightest possible colors.

None � Does not use a color correction so the colors you specified in the 
application for your job are not altered.

� Use when you have specified colors from the PANTONE® Color Chart.

SWOP Press   � Matches U.S. press standards using the specification for Web Offset 
Publications.

Euroscale Press � Emulates the Euroscale 4-color process press mode.

Commercial Press   � Emulates a 4-color process commercial press mode.

SNAP Press    � Matches the standards for printing on uncoated and newsprint papers 
using the specifications for Non-Heat Advertising Printing.

DIC    � Matches Dai Nippon printing inks on coated paper.

Toyo    � Matches commercial Toyo printing inks on coated paper.

Black and White    � Produces a black-and-white version of a document.

� Colors converted to grayscale.

� Use to print page masters for photocopying in black-and-white.

Fax Friendly � Colors are converted to black-and-white patterns.

� Fax Friendly is recommended for making prints that you plan to copy 
or fax.
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Advanced Features 
Secure prints, proof prints, and saved prints
You can choose one of the following special job types:

� Secure Print: Print confidential documents; your four-digit numerical password 
(PIN)-protected jobs are stored on the printer’s hard disk drive. The jobs print only 
after you enter the PIN (4-digit number) on the printer's front panel.

� Proof Print: Print only one copy of a multiple copy job so you can proof the copy. If 
you want to print the remaining copies, select the job name on the printer's front 
panel.

� Saved Print: Store the job on the hard disk so you can print it on demand. The job 
is not deleted after printing.

Note

These jobs are stored on the hard drive and remain in the printer even when it is 
powered off. There is a limit of 50 jobs allowed on the hard drive. After you have 
reached the 50 job limit, the oldest job will be automatically deleted.

Printing secure print, proof print, and saved print jobs

You specify that the job is a secure print, proof print, or saved print job in a supported 
driver:

� Windows 95 / Windows 98 PostScript driver:
On the Setup tab, choose the job type. For a secure print job, enter a numerical 
password (up to four-digits) to assign to this job. For proof prints and saved prints, 
enter the name you want to give this job.

� Windows 2000 / Windows NT driver:
On the Output Options tab, choose the job type. For a secure print job, enter a 
numerical password (up to four-digits) to assign to this job. For proof print and saved 
print jobs, enter the name you want to give this job.

� LaserWriter 8.6 or 8.7 driver:
In the Print dialog box, select the Job Type pull-down menu, then choose the job type. 
For a secure print job, enter a numerical password (up to four-digits) to assign to this 
job. For saved print job, also enter the name you want to give this job.

To print your secure print jobs, specify the PIN (4-digit password) on the printer's front 
panel:

1. With Menus highlighted, scroll to the Printable Pages Menu by pressing the Down 
Arrow key.

2. Press the OK key.

3. Scroll to Secure Print Jobs by pressing the Down Arrow key.

4. Press the OK key.
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Advanced Features
5. Scroll to the correct number for the first digit of the PIN (4-digit password) by pressing 
the Down Arrow or Up Arrow key.

Note

If you entered less than four digits in the driver’s Password field, enter zeros 
before your PIN (password) number until there are four digits entered in the front 
panel. For example, if you entered 222 in the driver, enter 0222 in the front 
panel.

6. Press the OK key.

7. Repeat step 5 for the second, third, and fourth digits.

8. Scroll to Print by pressing the Down Arrow key.

9. Press the OK key to print all jobs sharing that PIN.

To print a saved print job or the remaining copies of a proof print job, select the job name 
on the printer's front panel:

1. With Menus highlighted, scroll to the Printable Pages Menu by pressing the 
Down Arrow key.

2. Press the OK key.

3. Scroll to Proof Print Jobs or Saved Print Jobs (as applicable) by pressing the 
Down Arrow key.

4. Press the OK key.

5. Scroll until you find your job name by pressing the Down Arrow key.

6. Press the OK key.

7. Scroll to Print by pressing the Down Arrow key.

8. Press the OK key.

9. Scroll to the desired number of copies by pressing the Down Arrow key.

10. Press the OK key to print the job.

To delete a saved print job or the remaining copies of a proof print job, select the job name 
on the printer's front panel:

1. With Menus highlighted, scroll to the Printable Pages Menu by pressing the Down 
Arrow key.

2. Press the OK key.

3. Scroll to Proof Print Jobs or Saved Print Jobs by pressing the Down Arrow 
key.

4. Press the OK key.

5. Press the Down Arrow until you find your job name.

6. Press the OK key.

7. Scroll to Delete by pressing the Down Arrow key.

8. Press the OK key to delete the job.
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Separation pages
You can have the printer insert a separation page (a divider page) after a print job, between 
copies of a print job, or between individual pages of a print job. You can also specify the 
tray/source to use for the separation pages.

You can specify separation pages in a supported driver:

� Windows 95 / Windows 98 PostScript driver:
On the Output Options tab, select the location of the separation pages and, if desired, 
the source.

� Windows 2000 / Windows NT driver:
On the Output Options tab, select the location of the separation pages and, if desired, 
the source.

� LaserWriter 8.6 or 8.7 driver: 
In the Print dialog box, select the Advanced Media Handling pull-down menu, then 
select the location of the separation pages and, if desired, the source. 

Note

When stapling is activated, the separation page will be stapled to the prints.

Collating copies
When you print multiple copies of a print job, you can have it collated at the printer. Each 
copy (pages 1, 2, and 3, etc.) is printed before the next copy. Otherwise, the printer prints 
all copies of page 1, then all copies of page 2, etc.

Note

Many applications have a collate option in their Print dialog box. Since collation 
done at the printer is faster than collation performed by an application, select 
collation in the printer driver for faster printing of a collated job.

You can specify collation in a supported driver:

� Windows 95 / Windows 98 PostScript driver:
On the Output Options tab, check the Collate checkbox.

� Windows 2000 / Windows NT driver:
On the Output Options tab, check the Collate checkbox.

� LaserWriter 8.6 or 8.7 driver: 
In the Print dialog box, select the Advanced Media Handling pull-down menu, then 
select whether to have Quick Collate on or off.
6 Phaser 7700 Color Printer



Advanced Features
N-up
When printing a multiple-page document, you can choose to print more than one page on 
a single sheet of paper. You can choose to print one, two, four, six, nine, or 16 pages per 
sheet. When you print more than one page on a sheet, you can also print a border around 
each page.

You can select N-up in a supported driver:

� Windows 95 / Windows 98 PostScript driver:
On the Setup tab, click the More Layout Options button, then choose the number of 
pages per sheet from the drop-down list.

� Windows 2000 driver:
On the Layout tab, choose the number of pages per sheet from the drop-down list.

� Windows NT driver:
From the Properties tab, select the Advanced tab. Under Document Options, select 
the desired Page Layout (N-up) Option.

� LaserWriter 8.6 or 8.7 driver:
In the Print dialog box, select the Layout pull-down menu, then select the number of 
pages per sheet.

Booklet printing
You can print a document in the form of a small book. The printer automatically reduces 
each page image by 50 percent and prints two pages per sheet of paper. The pages are 
printed in the correct order so that you can fold and staple the pages to create a booklet.

Note

You can create booklets for any paper size that is supported for 2-sided (duplex) 
printing.
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When you choose Print Booklet Style, you can also specify the creep and gutter. The gutter 
is the horizontal distance from the fold to the page image (in points). The creep is the 
distance that page images are shifted inward (in 10ths of a point); this compensates for the 
thickness of the folded paper, which otherwise would cause the inner page images to shift 
slightly outward.

You can select booklet printing in a supported Windows driver:

Note

There is no Macintosh printer driver support for this feature.

� Windows 95 / Windows 98 PostScript driver:
On the Setup tab, click the More Layout Options button, then check the Print Booklet 
Style checkbox in the More Layout Options dialog box. 

� Windows 2000 driver:
On the Layout tab, choose Booklet from the drop-down list.

� Windows NT driver:
From the Properties tab, select the Advanced tab. Under Document Options, select 
the desired booklet from the Page Layout (N-up) Option.

Negative and mirror images
You can print your pages as a negative image (reverses the light and dark areas in your 
printed image) and/or mirror image (flips images horizontally on pages when printed).

You can select negative or mirror images in a supported driver:

� Windows 95 / Windows 98 PostScript driver:
On the Setup tab, click the More Layout Options button, then click the Print as a 
Negative Image and/or Print as a Mirror Image checkbox in the More Layout Options 
dialog box. 

� Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click the Advanced button. In the dialog 
box under Document Options and PostScript Options, select either Yes or No for 
Mirrored Output and Negative Output.

Gutter Creep
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� Windows NT driver:
From the Properties tab, select the Advanced tab. Under Document Options and 
PostScript Options, select either Yes or No for Mirrored Output and Negative Output.

� LaserWriter 8.6 or 8.7 driver: 
From the File menu, select Page Setup, choose PostScript Options from the 
pull-down menu, and then select Invert Image (to print a negative image) or Flip 
Horizontal (to print a mirror image).

Scaling
You can reduce or enlarge your page images when they are printed. You select a scaling 
value between 25 and 400 percent. The default is 100 percent.

You can scale the pages by using the supported driver:

� Windows 95 / Windows 98 PostScript driver:
On the Setup tab, click the More Layout Options button, then specify the percentage 
to scale in the Percentage field. 

� Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click the Advanced button. In the dialog 
box under Graphic, select the desired percentage for Scaling.

� Windows NT driver:
From the Properties tab, select the Advanced tab. Under Graphic, select the desired 
percentage for Scaling.

� LaserWriter 8.6 or 8.7 driver: 
From the File menu, select Page Setup and then specify the percentage in the box 
after Scale.

Watermarks
A watermark is text (independent of that provided by the printing application) that is 
printed on the first page or every page of the document. You can create a watermark or edit 
an existing watermark’s text, color, location, and angle. You can also choose to print the 
watermark only on the first page, print the watermark in the background, or print the text 
of the watermark as an outline (instead of filled text).

Note

Not all applications support watermark printing.

You can select, create, and edit watermarks using a supported Windows driver:

Note

There is no Macintosh printer driver support for this feature.
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Advanced Features 
� Windows 95 / Windows 98 PostScript driver:
On the Setup tab, click the More Layout Options button, and then click the 
Watermark button to display the Watermarks dialog box. 

� Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click the Advanced button. In the dialog 
box, select the desired Watermark.

� Windows NT driver:
From the Properties tab, select the Advanced tab. Under Document Options, select 
the desired Watermark.

Image smoothing
Image Smoothing blends adjacent colors in low-resolution images for smoother color 
transitions. For example, use Image Smoothing to improve the appearance of a 72-dpi 
image downloaded from the World Wide Web. Image Smoothing is not recommended for 
300-dpi or higher images.

You can select Image Smoothing in a supported driver:

� Windows 95 / Windows 98 PostScript driver:
On the Setup tab, click the More Layout Options button, then click the Image 
Smoothing checkbox in the More Layout Options dialog box.

� Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click the Advanced button. In the dialog 
box under Printer Features, select either On or Off for Image Smoothing.

� Windows NT driver:
From the Properties tab, select the Advanced tab. Under Printer Features, select 
either On or Off for Image Smoothing.

� LaserWriter 8.6 or 8.7 driver:
In the Print dialog box, select the Advanced Media Handling pull-down menu, then 
select whether to have Image Smoothing on or off.
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Color and Color Sampler Charts
You can have the colors on your print match particular press specifications or match your 
computer screen’s colors. To do this, pick a color correction in the printer driver; see 
page 3 for more information.

You can use color sampler charts to help select the colors to use in your application. Refer 
to the next section for more information.

For information on PANTONE Colors, refer to page 15.

Color Sampler Charts
Color sampler charts are colored rectangles with each color’s component values; they help 
you select colors in an application that can be reproduced on your printer.

Component values are percentages of each color — CMYK (Cyan, Magenta, Yellow, Black), 
RGB (Red, Green, Blue), or HSB (Hue, Saturation, Brightness) — that combine to make a 
particular color.

Which color chart you print and use depends on how your application selects color. For 
information on color selection, refer to the application’s documentation, then print one or 
more of the color sampler charts.

Xerox

Process Color

Sampler

This Graphic Arts guide is

designed to help you choose

colors on the Tektronix color

printers. These reference

pages can be combined into

a wall reference chart, or

held in a reference book.

To assemble the

chart combine the

pages in this order:

Copyright © Xerox Corporation

0726-89
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Color and Color Sampler Charts 
Each color sampler chart is several pages long. Either:

� Print them in panels and connect them to form a wall chart

� Print them and place them in a binder for easy reference

Note

For information on printing the PANTONE Color sampler chart, refer to page 16.

 

Depending on the type of color sampler chart, you can print the chart by using:

� A selection on the printer’s front panel

� CentreWare Internet Services

� A utility file

Printing a color sampler chart from the printer’s front panel

Note

Use the same print quality mode, color correction and paper type, to print the 
chart that you plan to use when printing from your application; see page 3 for 
more information. If you use any other print quality mode, color correction or 
paper type in the printer driver when you print from an application, the colors 
may not match the chart. Also, use the same paper for the color sampler chart 
that you will be using.

To specify the print quality mode and color correction to use for the color sampler chart, 
on the printer's front panel:

1. With Menus highlighted, press the OK key.

2. Scroll to the Printer Setup Menu by pressing the Down Arrow key.

3. Press the OK key.

4. Scroll to Job Defaults Menu by pressing the Down Arrow key.

5. Press the OK key.

6. With Set Print Quality Mode highlighted, press the OK key.

Color sampler chart descriptions

Color sampler chart Number
of pages*

Front panel 
selection

CentreWare 
IS

 Utility
file

CMYK Sampler 
Chart

Cyan, magenta, yellow, and 
black color model 18 • • •

RGB Sampler 
Chart

Red, green, and blue color 
model 12 • • •

HSB Sampler 
Chart 

Hue, saturation, and 
brightness color model 12 •

* This is the number of pages if you use one-sided printing; if you use two-sided printing, the 
number of pages will be half of this value.
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7. Scroll to the desired print quality mode by pressing the Down Arrow key.

8. Press the OK key to select that print quality mode.

9. Return to the Job Defaults Menu by pressing the Back key.

10. Scroll to Set TekColor Correction by pressing the Down Arrow key.

11. Press the OK key.

12. Scroll to the desired color correction by pressing the Down Arrow key.

13. Press the OK key to select that color correction.

To print the color sampler chart, on the printer's front panel:

1. With Menus highlighted, scroll to the Printable Pages Menu by pressing the Down 
Arrow key.

2. Press the OK key.

3. Scroll to either Print CMYK Sampler Pages or Print RGB Sampler Pages by 
pressing the Down Arrow.

4. Press the OK key.

Printing the colors from an application
1. Using the color sampler chart, select the desired colors in your application.

2. From your application, apply the desired colors in your document or graphic by 
entering the specific CMYK or RGB values as indicated on the sampler chart.

3. When you print your document or graphic, select the same color correction and print 
quality mode in the printer driver that you used to print the color sampler chart.

Printing the color sampler charts with CentreWare IS
1. Access your printer’s Internet Services home page; refer to page 29 for more 

information.

2. Click the Print button to display the Print tab.

3. On the left side of the page, click Print Color Samplers.

4. On the Print Color Samplers page, select the color sampler (either RGB or CMYK) and 
click the green button.
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Color and Color Sampler Charts 
Printing the color sampler charts with utility files

From a Macintosh

1. To print the color sampler charts with utility files, use the Apple Printer Utility. For 
information about installing the Apple Printer Utility, refer to page 37.        

2. Download the desired color sampler utility file to the printer. Refer to page 39 for the 
steps to download utility files using the Apple Printer Utility.

From a PC or workstation  

1. Locate the utility files on the CD-ROM in the phsr7700 folder inside the utility folder. 
For more information, refer to page 37. You can use the files directly from the 
CD-ROM or copy the files to your computer’s hard disk.        

2. Download the desired color sampler utility file to the printer. Refer to page 41 for the 
steps to download utility files; the procedure depends on the operating system your 
PC uses.
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PANTONE Colors
PANTONE Color files for your printer include printer-specific color library files for some 
specific applications and a file to print the PANTONE Color sampler chart.

For the latest information on color libraries, contact your local Xerox reseller or visit the 
Xerox web site at: www.xerox.com/officeprinting

Printing PANTONE Colors from the color selection book

In some applications, you can select colors from the PANTONE Process Imaging Guide. 
These colors can be proofed on your Phaser printer before final output on a printing press. 
For this method, the printer-specific PANTONE Color files are not required.

1. From the application, select and apply PANTONE Colors. Use the individual color 
values from the PANTONE Process Imaging Guide.

2. Print your document, selecting Commercial Press or SWOP Press for the color 
correction in the printer driver; see page 3 for more information.

3. When you are satisfied with the proof, the file can be separated for printing press 
plates without adjustment to the file.

Printing printer-specific PANTONE Colors

Your printer can produce process color simulations of PANTONE Spot Colors.

1. Print a copy of the PANTONE Color chart; see page 16 for more information.

2. Within the application, define the desired color in your document by using the 
individual CMYK values that appear on the sampler chart.

3. Print your document, selecting None for the color correction in the printer driver; (see 
page 3 for more information). For best results, use the proper print quality setting and 
the same type of paper that you used to print the PANTONE Color chart.

For final output on a color printing press (colors printed as a process color, not spot 
colors):

1. Open the application.

2. Replace the printer’s PANTONE Process Colors with standard PANTONE Colors.

3. Separate the file for printing press plates.
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Color and Color Sampler Charts 
Installing the PANTONE Color files

To install the files from the web:

1. Start your web browser (such as Netscape Navigator or Internet Explorer).

2. Enter the following web address: www.xerox.com/officeprinting/  

3. Choose the Phaser 7700 printer from the drop-down list.

4. From the pull-down lists, select your computer platform and PANTONE for type of 
file.

5. Click the Go button to search the web site and display the list of files to download.

6. Download the files to the disk:

a. Click on the name of the file.

b. Select Save this file to disk.

c. Click the OK button. 

d. Select the location to save the file.

e. Click the Save button to download it to your computer.

f. Repeat Steps a-e for each file that you want to download.

7. Navigate to the location where you saved the file(s) and extract the file.

Printing the PANTONE Color Chart from a Macintosh

To print individual pages from the PANTONE Color chart, use Acrobat Reader: 

1. To install Acrobat Reader, if it is not already installed, insert the printer’s CD-ROM in 
your computer’s drive, go to the Utilities folder, and follow the on-screen instructions 
to install Acrobat Reader onto your computer’s hard disk.

2. Locate the Pantone files you downloaded from the web site and double-click the 
desired PDF file.

3. View and print pages from the PDF file.

Note

Print only with the None color correction, since other settings cause PANTONE 
Colors to print differently than expected. Use the same paper that you plan to use 
for your application. Refer to page 3 for more information. Print on the paper you 
plan to use for your application.

For best results and truest color:

� Print the chart on Phaser Premium Color Printing Paper.

� Select one-sided printing when printing the color chart in order to reduce the 
effects of color show-through.
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Color and Color Sampler Charts
Printing the PANTONE Color Chart from a PC

To print individual pages from the PANTONE Color chart, use Acrobat Reader: 

1. To install Acrobat Reader, if it is not already installed, insert the printer’s CD-ROM in 
your computer’s drive, go to the Utilities folder, and follow the on-screen instructions 
to install Acrobat Reader onto your computer’s hard disk.

2. Locate the Pantone files you downloaded from the web site and double-click the 
desired PDF file.

3. View and print pages from the PDF file. For best results, print on paper.

Note

Print only with the None color correction, since other settings cause PANTONE 
Colors to print differently than expected. Use the same paper that you plan to use 
for your application. Refer to page 3 for more information. Print on the paper you 
plan to use for your application.

For best results and truest color:

� Print the chart on Phaser Premium Color Printing Paper.

� Select one-sided printing when printing the color chart in order to reduce the 
effects of color show-through.
Advanced Features and Troubleshooting Manual 17



Color and Color Sampler Charts 
Adjusting Color Balance
Over the life of the printer, colors may change. For example, reds may begin to take on a 
purple cast, or blues may take on a green cast. This can happen during the normal use of a 
color printer, during set-up or when toners and print cartridges are replaced. It can be 
easily remedied by adjusting the color balance.

This front panel procedure involves printing a demonstration page, a series of test pages 
and adjusting the colors based on the appearance of the test pages.

Note

At any time, you can reset the printer to the previous settings or to the factory 
defaults.

Printing the Color Calibration Tutorial

The Color Calibration Tutorial contains an overview of the color adjustment procedure. 
Before starting this procedure, print and review the Color Calibration Tutorial.

1. On the front panel, scroll to the Support menu by pressing the Up or Down Arrow 
key.

2. Press the OK key.

3. Select the Improve Print Quality? menu by pressing the Down or Up Arrow key.

4. Press the OK key.

5. Select the Calibrate Colors Menu by pressing the Down or Up Arrow key.

6. Press the OK key.

7. Select the Print Tutorial Page menu item by pressing the Down or Up Arrow 
key.

8. Press the OK key to print the tutorial page.

9. Follow the instructions on this page to adjust the color balance.
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Restore previous settings

You can return the color settings to the ones that existed before you saved the last color 
balance adjustments.

1. On the front panel, scroll to the Support menu by pressing the Up or Down Arrow 
key.

2. Press the OK key.

3. Select the Improve Print Quality? menu by pressing the Down or Up Arrow key.

4. Press the OK key.

5. Select the Calibrate Colors Menu by pressing the Down or Up Arrow key.

6. Press the OK key.

7. Select the Restore Previous Settings by pressing the Down or Up Arrow key.

8. Press the OK key to reset the settings.

Restore factory settings

You can reset settings for density and color balance to the factory-default values.

1. On the front panel, scroll to the Support menu by pressing the Up or Down Arrow 
key.

2. Press the OK key.

3. Select the Improve Print Quality? menu by pressing the Down or Up Arrow key.

4. Press the OK key.

5. Select the Calibrate Colors Menu by pressing the Down or Up Arrow key.

6. Press the OK key.

7. Select the Restore Factory Settings by pressing the Down or Up Arrow key.

8. Press the OK key.

9. Select the Restore Factory Settings NOW menu item by pressing the Down or 
Up Arrow key.

10. Press the OK key to reset the settings to the factory defaults.
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PhaserPrint Plug-in for Photoshop  
The PhaserPrint™ plug-in, included on the printer’s CD-ROM, operates within the 
Photoshop application on Macintosh computers. With PhaserPrint, you can improve 
image transfer time and gain easy access to Phaser printer features and other media 
features.

Note

PhaserPrint software produces correct output only on supported Phaser printers. 
If you use this plug-in with a printer not listed in the PhaserPrint dialog box, the 
image may be placed incorrectly on the page, the colors may look incorrect, or 
the file may not print.

Installing the plug-in

Compatibility requirements:  

� Photoshop 3.0 and higher

� System 7.6.1 and higher

To install the plug-in on the Macintosh: 

1. From the printer’s CD-ROM, run the Installer application.

2. Select either Easy Install or Custom Install.

3. When performing a custom install, select PhaserPrint plug-in for Photoshop.

4. Click the Install button. The file is then installed in the Photoshop application’s 
folder on your computer’s hard disk.

Using the plug-in  
1. Specify the default printer:

a. Open the Chooser.

b. Select a PostScript driver (such as the Apple LaserWriter 8).

c. Select your printer.

Note

PhaserPrint software works like a printer driver, and prints to the 
printer you selected in the Chooser.

2. Open Photoshop and open an image file.
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PhaserPrint Plug-in for Photoshop
3. From Photoshop’s Mode menu, select one of the following image modes supported by 
PhaserPrint:

� Grayscale

� Indexed Color

� RGB Color

� CMYK Color

� Lab Color 

4. From the File menu, select Export and then select PhaserPrint.

5. In the PhaserPrint dialog box, select your printer in the Printer Model field.

6. Make other selections in the PhaserPrint dialog box. For more information on the 
selections in the dialog box or the plug-in’s features, refer to the online help.

7. Click the Print button in the PhaserPrint dialog box.
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Fonts
Your Phaser 7700 Color Printer uses the following types of fonts:

� Resident fonts

� Fonts downloaded onto the hard drive

� Fonts downloaded into memory

� Fonts downloaded with your print job from the application

ATM (Adobe Type Manager) software helps your computer display these fonts on screen 
as they will appear in your prints. If you don’t already have ATM on your computer, 
install it from the printer’s CD-ROM. Also install the printer’s screen fonts from the ATM 
folder.

Resident typefaces (PostScript)
Printer-resident fonts are always available for printing. All printer configurations are 
shipped with 136 resident fonts plus the Central and Eastern European encoding for many 
of the fonts. To print a sample of the printer’s fonts, see page 27.

Resident Roman typefaces:

AdobeSansMM

AdobeSerifMM

AlbertusMT
AlbertusMT-Italic
AlbertusMT-Light

AntiqueOlive-Bold
AntiqueOlive-Compact
AntiqueOlive-Italic
AntiqueOlive-Roman

Apple-Chancery

Arial-BoldItalicMT
Arial-BoldMT
Arial-ItalicMT

ArialMT

AvantGarde-Book
AvantGarde-BookOblique

AvantGarde-Demi
AvantGarde-DemiOblique

Bodoni
Bodoni-Bold
Bodoni-BoldItalic
Bodoni-Italic

Bodoni-Poster
Bodoni-PosterCompressed

Bookman-Demi
Bookman-DemiItalic

Bookman-Light
Bookman-LightItalic

AntiqueOliveCE-Bold
AntiqueOliveCE-Compact
AntiqueOliveCE-Italic
AntiqueOliveCE-Roman

Apple-ChanceryCE

ArialCE
ArialCE-Bold
ArialCE-BoldItalic
ArialCE-Italic

AvantGardeCE-Book
AvantGardeCE-BookOblique

AvantGardeCE-Demi
AvantGardeCE-DemiOblique

BodoniCE
BodoniCE-Bold
BodoniCE-BoldItalic
BodoniCE-Italic

BodoniCE-Poster
BodoniCE-PosterCompressed

BookmanCE-Demi
BookmanCE-DemiItalic

BookmanCE-Light
BookmanCE-LightItalic
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Carta

Chicago

Clarendon
Clarendon-Bold
Clarendon-Light

CooperBlack
CooperBlack-Italic

Copperplate-ThirtyThreeBC
Copperplate-ThirtyTwoBC

Coronet-Regular

Courier
Courier-Bold
Courier-BoldOblique
Courier-Oblique

Eurostile
Eurostile-Bold
Eurostile-BoldExtendedTwo
Eurostile-ExtendedTwo

Geneva

GillSans
GillSans-Bold
GillSans-BoldCondensed
GillSans-BoldItalic
GillSans-Condensed
GillSans-ExtraBold
GillSans-Italic
GillSans-Light
GillSans-LightItalic

Goudy
Goudy-Bold
Goudy-BoldItalic
Goudy-ExtraBold
Goudy-Italic

Helvetica
Helvetica-Bold
Helvetica-BoldOblique
Helvetica-Condensed
Helvetica-Condensed-Bold
Helvetica-Condensed-BoldObl
Helvetica-Condensed-Oblique
Helvetica-Narrow
Helvetica-Narrow-Bold
Helvetica-Narrow-BoldOblique
Helvetica-Narrow-Oblique
Helvetica-Oblique

HoeflerText-Black
HoeflerText-BlackItalic
HoeflerText-Italic
HoeflerText-Ornaments
HoeflerText-Regular

JoannaMT
JoannaMT-Bold
JoannaMT-BoldItalic
JoannaMT-Italic

LetterGothic
LetterGothic-Bold
LetterGothic-BoldSlanted
LetterGothic-Slanted

ChicagoCE

ClarendonCE
ClarendonCE-Bold
ClarendonCE-Light

CoronetCE-Regular

CourierCE
CourierCE-Bold
CourierCE-BoldOblique
CourierCE-Oblique

EurostileCE
EurostileCE-Bold
EurostileCE-BoldExtendedTwo
EurostileCE-ExtendedTwo

GenevaCE

GillSansCE-Bold
GillSansCE-BoldCondensed
GillSansCE-BoldItalic
GillSansCE-Condensed
GillSansCE-ExtraBold
GillSansCE-Italic
GillSansCE-Light
GillSansCE-LightItalic
GillSansCE-Roman

HelveticaCE
HelveticaCE-Bold
HelveticaCE-BoldOblique
HelveticaCE-Cond
HelveticaCE-CondBold
HelveticaCE-CondBoldObl
HelveticaCE-CondObl
HelveticaCE-Narrow
HelveticaCE-NarrowBold
HelveticaCE-NarrowBoldOblique
HelveticaCE-NarrowOblique
HelveticaCE-Oblique

HoeflerTextCE-Black
HoeflerTextCE-BlackItalic
HoeflerTextCE-Italic
HoeflerTextCE-Regular

JoannaMTCE
JoannaMTCE-Bold
JoannaMTCE-BoldItalic
JoannaMTCE-Italic

LetterGothicCE
LetterGothicCE-Bold
LetterGothicCE-BoldSlanted
LetterGothicCE-Slanted
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LubalinGraph-Book
LubalinGraph-BookOblique
LubalinGraph-Demi
LubalinGraph-DemiOblique

Marigold

MonaLisa-Recut

Monaco

NewCenturySchlbk-Bold
NewCenturySchlbk-BoldItalic
NewCenturySchlbk-Italic
NewCenturySchlbk-Roman

NewYork

NotDefFont

Optima
Optima-Bold
Optima-BoldItalic
Optima-Italic

Oxford

Palatino-Bold
Palatino-BoldItalic
Palatino-Italic
Palatino-Roman

StempelGaramond-Bold
StempelGaramond-BoldItalic
StempelGaramond-Italic
StempelGaramond-Roman

Symbol

Tekton

Times-Bold
Times-BoldItalic
Times-Italic
Times-Roman

TimesNewRomanPS-BoldItalicMT
TimesNewRomanPS-BoldMT
TimesNewRomanPS-ItalicMT
TimesNewRomanPSMT

Univers
Univers-Bold
Univers-BoldExt
Univers-BoldExtObl
Univers-BoldOblique
Univers-Condensed
Univers-CondensedBold
Univers-CondensedBoldOblique
Univers-CondensedOblique
Univers-Extended
Univers-ExtendedObl
Univers-Light
Univers-LightOblique
Univers-Oblique

Wingdings-Regular

ZapfChancery-MediumItalic

ZapfDingbats

LubalinGraphCE-Book
LubalinGraphCE-BookOblique
LubalinGraphCE-Demi
LubalinGraphCE-DemiOblique

MonacoCE

NewCenturySchlbkCE-Bold
NewCenturySchlbkCE-BoldItalic
NewCenturySchlbkCE-Italic
NewCenturySchlbkCE-Roman

NewYorkCE

OptimaCE-Bold
OptimaCE-BoldItalic
OptimaCE-Italic
OptimaCE-Roman

PalatinoCE-Bold
PalatinoCE-BoldItalic
PalatinoCE-Italic
PalatinoCE-Roman

StempelGaramondCE-Bold
StempelGaramondCE-BoldItalic
StempelGaramondCE-Italic
StempelGaramondCE-Roman

TimesCE-Bold
TimesCE-BoldItalic
TimesCE-Italic
TimesCE-Roman

TimesNewRomanCE
TimesNewRomanCE-Bold
TimesNewRomanCE-BoldItalic
TimesNewRomanCE-Italic

UniversCE-Bold
UniversCE-BoldExt
UniversCE-BoldExtObl
UniversCE-BoldOblique
UniversCE-Condensed
UniversCE-CondensedBold
UniversCE-CondensedBoldOblique
UniversCE-CondensedOblique
UniversCE-Extended
UniversCE-ExtendedObl
UniversCE-Light
UniversCE-LightOblique
UniversCE-Medium
UniversCE-Oblique

ZapfChanceryCE-MediumItalic
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Resident typefaces (PCL5C)
For PCL5C (Printer Command Language) printing, the printer supports Courier, Times, 
and Universe typefaces in medium, bold, italic medium, and italic bold. In addition, there 
are 46 PCL fonts. The printer port must be set to AutoSelect (which is the default) or PCL 
for the printer to accept PCL data.

Resident PCL typefaces 

Downloading fonts    
To supplement the resident fonts (which are always available for printing), downloadable 
fonts can be sent from your computer and be stored in the printer’s memory or on the 
printer’s hard drive. Adding more printer memory expands the number of fonts that can be 
stored on your printer. Refer to the Phaser 7700 Color Printer User Guide or the Xerox web 
site for part numbers of the memory.

By downloading fonts to a hard disk or memory, you save print time when you use a 
Macintosh to print large documents or print several documents that use those fonts. 
Because it has bi-directional communication with the printer, the Macintosh identifies 
which fonts are already available in the printer memory and on the hard drive, and thus 
doesn’t spend time downloading those same fonts from the application.

Note

Because PC drivers don’t have bi-directional font communication with the 
printer, the PC only knows what fonts came with the printer. All other fonts are 
downloaded from the application, even if they already were downloaded to the 
hard disk or memory.

AlbertusE-ExtraBold
AlbertusE-Medium

AntiqueOliveE-Bold
AntiqueOliveE-Italic
AntiqueOliveE-Regular

ArialE
ArialE-Bold
ArialE-BoldItalic
ArialE-Italic

ClarendonE-Condensed

CoronetE

CourierE-Bold
CourierE-BoldItalic
CourierE-Italic
CourierE-Regular

GaramondE-Antiqua
GaramondE-Halbfett
GaramondE-Kursiv
GaramondE-KursivHalbfett

LetterGothicE-Bold
LetterGothicE-Italic
LetterGothicE-Regular

MarigoldE

OptimaE-Bold
OptimaE-BoldItalic
OptimaE-Italic
OptimaE-Regular

SymbolE

TimesE-Bold
TimesE-BoldItalic
TimesE-Italic
TimesE-Roman
TimesNewRomanE
TimesNewRomanE-Bold
TimesNewRomanE-BoldItalic
TimesNewRomanE-Italic

UniversE-Bold
UniversE-BoldCondensed
UniversE-BoldCondensedItalic
UniversE-BoldItalic
UniversE-Condensed
UniversE-CondensedItalic
UniversE-Italic
UniversE-Medium
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Before printing, make sure that the fonts specified in your document are installed in the 
printer or are set up correctly. If you request a font in an application that is not resident in 
the printer, is not correctly installed, or is not downloaded from the application in the 
print job, the text is printed in Courier typeface.

The printer accepts these (and other) downloadable fonts:

� Type 1

� Type 3 

� Adobe

� Agfa

� Bitstream

� Microsoft

� Apple

� TrueType (scalable to any point size; looks the same on-screen and printed).

Downloading fonts from a Macintosh  

Use the Apple Printer Utility to download fonts to the printer.

Note

In order to download the fonts to the printer with the Apple Printer Utility, the 
SysStart Job must be disabled on the printer’s front panel; refer to page 34 for 
more information on SysStart Job.

1. If you don’t already have the Apple Printer Utility on your computer, install it from 
the printer’s CD-ROM.

2. Start the Apple Printer Utility by double-clicking the icon (in the PhaserTools folder 
on your computer’s hard disk).

3. In the Printer Selector dialog box:

a. Under AppleTalk Zones, select your printer’s zone.

b. Under Printers, select your Phaser 7700 printer.

c. Click the Open Printer button.

4. In the printer’s dialog box, click the arrow next to Printer Preferences.

5. Click the arrow next to Fonts to display the list of installed fonts and their locations.

6. Click the Add button.

7. In the dialog box, select the folder containing the font you want to download, select 
the font, and click the Add button. The font is listed as ready to download.

Note

To add all of the fonts in the folder to the list of fonts to download, click the 
Add All button. If you decide not to download a font, highlight the font in the list 
of fonts to download and click the Remove button.
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8. For Destination, select the download location: either the printer’s memory or the hard 
disk.

9. To download the fonts in the list, click the Send button.

Note

To remove downloaded fonts from the printer, follow steps 2 through 5, 
highlight the font in the list under Fonts (in the printer’s dialog box), and then 
click the Remove button.

Downloading fonts from a PC  

Use the Xerox CentreWare Font Download Utility to download fonts to the printer. For 
detailed information, refer to the online help.

1. If you don’t already have the Xerox CentreWare Font Download Utility on your 
computer, install it from the Advanced Network Management Tools CD-ROM. Refer 
to page 41.

2. Start the Xerox CentreWare Font Download Utility.

3. Select the printer from the List of Printers.

4. Click the Fonts / Forms Manager button.

5. In the Fonts / Forms Manager dialog box:

a. For Storage Device Type, select Printer Hard Disk.

b. For Resource Type, select PostScript Fonts.

c. Click the Browse button and select the fonts you want to download. They are 
then displayed in the Selected Fonts list.

d. Click the Download button.

6. If you want to print a list of the fonts on the printer, refer to page 28.

7. When you have finished downloading fonts, click the Done button.

Printing a list of resident fonts   

Listing the fonts from a Macintosh  

Use the Apple Printer Utility to list the fonts available on the printer.

Note

In order to send the list of fonts to the printer with the Apple Printer Utility, the 
SysStart Job must be disabled on the Phaser 7700 front panel; refer to page 34 for 
more information on SysStart Job.

1. If you don’t already have the Apple Printer Utility on your computer, install it from 
the printer’s CD-ROM. Refer to page 39.
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2. Start the Apple Printer Utility by double-clicking the icon (in the PhaserTools folder 
on your computer’s hard disk).

3. In the Printer Selector dialog box:

a. Under AppleTalk Zones, select your printer’s zone.

b. Under Printers, select your Phaser 7700 Color Printer.

c. Click the Open Printer button.

4. From the File menu, select Print Font Samples.

Listing the fonts from a PC  

Use the Xerox CentreWare Font Download Utility to list the fonts available on the printer. 
For detailed information, refer to the online help.

1. If you don’t already have the Xerox CentreWare Font Download Utility on your 
computer, install it from the Advanced Network Management Tools CD-ROM.

2. Start the Xerox CentreWare Font Download Utility.

3. Select the printer from the List of Printers.

4. Click the Fonts / Forms Manager button.

5. In the Fonts / Forms Manager dialog box:

a. For Font List Type, select PostScript Fonts / Forms.

b. Click the Print Font List button.

6. Click the Done button to exit the Fonts / Forms Manager dialog box.
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Printer Management
You can configure and manage your printer:

� On the front panel

� Using CentreWare IS Printer Management software

� Through Usage Profile Reports, which can be emailed when the printer needs 
attention (such as needing more paper)

This section covers the following features related to the operation of your printer:

� The printer’s Startup Page — see page 32

� Protected mode for the front panel menus — see page 33

� Sys/Start Job execution — see page 34

� Front panel intensity — see page 34

� Front panel contrast — see page 34

� Intelligent Ready mode — see page 34

� Front panel language — see page 35

� Automatic tray switching — see page 36

CentreWare IS Printer Management software
CentreWare Internet Services™ Printer Management software is a printer management tool 
that uses a web browser to connect to the printer and gather printer information:

� Job status

� Job accounting

� Printer usage

� Routine troubleshooting

� Configuration of printer settings

CentreWare IS requires a TCP/IP connection. To view information on your printer, enter 
your printer’s IP address as the URL in a web browser. For example, if your printer’s IP 
address is 113.25.72.34, the URL would be http://113.25.72.34. The CentreWare IS 
interface appears on your computer’s screen.

For detailed information on CentreWare IS Printer Management software, refer to its 
online help. You can access interactive troubleshooting assistance with PhaserSMART by 
selecting Technical Support from the Support tab.

For general information, access the following web site:

http://www.officeprinting.xerox.com/7700support/
then click the CentreWare link
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Usage Profile
A Usage Profile report provides a proactive strategy for service, maintenance, and 
administration of your printer. With Usage Profile, you can keep track of most printer 
parameters in detail. The Usage Profile helps you predict the ordering needs of customer- 
replaceable consumables for remote locations.

The Usage Profile report includes:

� Consumables usage

� Paper versus transparency usage

� Number and location of media jams

� Media tray usage

� Total number of pages printed

To print the Usage Profile report from the printer’s front panel:

1. With Menus highlighted, press the Up Arrow or Down Arrow key to scroll to 
Printable Pages.

2. Press the OK key.

3. Scroll to Print Usage Profile by pressing the Up Arrow or Down Arrow key.

4. Press the OK key.

Email notification
You can easily set up electronic mail notification of particular status conditions for three 
people — your system administrator, key user, and service agent. With mail notification, 
these people receive timely information on error conditions or supplies status. You enter 
their email addresses and set up the types of error conditions to be reported to each 
person, such as:

� Supplies (customer-replaceable consumables) low or out

� Empty media tray

� Error conditions

To set up email notification in CentreWare IS:

1. From your printer’s Internet Services home page, click the Properties button.

2. Enter the email addresses for the system administrator, key user, and service agent:

a. On the left side of the Properties page in CentreWare IS, click Mail Alerts.

b. On the MaiLinX Alerts page for MaiLinX (and Usage Profile Properties), 
select On.

c. Enter the appropriate email address for SysAdmin Email Address, Key User 
Email Address, and Service Email Address.

d. Specify the type of message that each person receives.

e. Click the Save Changes button on the bottom of the page.
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3. Specify the text and message text for the email:

a. On the MaiLinX Alerts page, click the MaiLinX Message Settings link.

b. For each recipient, specify the subject text and message text for the emails or 
choose default to have the recipient receive the default text.

c. Click the Save Changes button on the bottom of the page.

4. Specify the conditions under which an email will be sent to each of the three 
recipients:

a. On the MaiLinX Alerts page, click the Printer Unable to Print link.

b. Click the checkbox beside each error condition that you want to generate an 
email message to the recipient.

c. Click the Save Changes button on the bottom of the page.

d. Return to the MaiLinX Alerts page. (You can click the Back button in the 
browser.)

e. On the MaiLinX Alerts page, click the Printer Warnings link.

f. Click the checkbox for each warning condition that you want to generate an 
email message to the recipient.

g. Click the Save Changes button on the bottom of the page.

For detailed information, refer to the CentreWare IS online help.
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Operational features

The printer’s Startup Page    

By default, the printer produces a Startup Page each time the printer is turned on or reset. 
If desired, you can disable the Startup Page.

There are three methods for turning on/turning off the Startup Page:

� From the printer’s front panel

� Using CentreWare IS Printer Management software

� Using utility files

To turn on/turn off the Startup Page from the printer’s front panel:

1. With Menus highlighted, press the OK key.

2. Scroll to the Printer Setup Menu, by pressing the Up Arrow or Down Arrow key.

3. Press the OK key.

4. Scroll to the Startup Page, by pressing the Up Arrow or Down Arrow key.

5. To change the setting, press the OK key.

To turn on/turn off the Startup Page using CentreWare IS Printer Management software:

1. From your printer’s Internet Services home page, click Properties.

2. On the left side of the Properties page in CentreWare IS, click Printer Defaults.

3. If desired, change the setting for Print Startup Page (under User Preferences on the 
Printer Defaults page).

4. Click the Save Changes button on the bottom of the page.

To turn on/turn off the Startup Page using utility files:

� Macintosh: Use the Apple Printer Utility (refer to page 40 for instructions).

� PC: Download one of the following utility files, as described on page 41:

� STARTPG.PS — turn on the Startup Page

� NOSTRTPG.PS — turn off the Startup Page
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Protected mode for the front panel menus      

You can have the printer enter "protected mode" to prevent users from changing front 
panel settings that may impact the prints of other users. Instead, users select printing 
features, such as color corrections, through the printer drivers only. In protected mode, 
users can access all menus except the Printer Setup Menu, the Network Setup Menu, the 
Service Tools Menu, and the calibration menus.

Note

You can temporarily override protected mode. Enter the menu system 
(by highlighting Menus and pressing the OK key), hold down the Cancel key and 
press the Back key. You can then access the Printer Setup Menu or the 
Network Setup Menu. These two menus are hidden again as soon as you exit 
the menu.

 There are two methods for entering/exiting protected mode:

� Using CentreWare IS Printer Management software

� Using utility files

To enter/exit protected mode using CentreWare IS Printer Management software:

1. From your printer’s Internet Services home page, click Properties.

2. On the left side of the Properties page in CentreWare IS, click Printer Defaults.

3. If desired, change the setting for Front Panel Menus (under User Preferences on the 
Printer Defaults page).

� Select Off to have the front panel display all menus. 

� Select On to limit the menu items displayed on the front panel.

4. Click the Save Changes button on the bottom of the page.

To enter/exit protected mode using utility files:

To enter or exit protected mode, download one of the following utility files:

� Macintosh:

� Menu Short — limits menu access

� Menu Long — expands menus

Refer to page 39 for downloading instructions.

� PC:

� MENUSHRT.PS — limits menu access

� MENULONG.PS — expands menus

Refer to page 41 for downloading instructions.
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SysStart Job execution  

A startup file (SysStart) is automatically run when you turn on or reset the printer. The 
Japanese, Chinese and Korean fonts are loaded from the Phaser hard drive when this file is 
executed. To customize the startup, use UsrStart.

Note

If the SysStart file contains an error, the printer ignores the remainder of the file 
and may not start up as expected.

Front panel intensity

To make the front panel text more readable, you can adjust the intensity of the front 
panel’s back lighting:

1. On the front panel, with Menus highlighted, press the OK key.

2. Scroll to Printer Setup Menu by pressing the Up Arrow or Down Arrow key.

3. Press the OK key.

4. Scroll to Set Front Panel Intensity by pressing the Up Arrow or Down Arrow 
key.

5. Press the OK key.

6. Scroll until the desired back light intensity is displayed. The intensity values range 
from 0 (no back light) to 10 (brightest back light).

7. Press the OK key.

Front panel contrast

To make the front panel text more readable, you can adjust the contrast between the text 
and the background:

1. On the front panel, with Menus highlighted, press the OK key.

2. Scroll to the Printer Setup Menu by pressing the Up Arrow or Down Arrow key.

3. Press the OK key.

4. Scroll to Set Front Panel Contrast by pressing the Up Arrow or Down Arrow 
key. 

5. Press the OK key.

6. Scroll the value until you achieve the desired contrast between the text and the 
background. The values range from 1 to 10.

7. Press the OK key.

Intelligent Ready mode

Intelligent Ready mode is an automated system that monitors the printer’s usage and 
warms up the printer when you are most likely to need it.    
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To turn Intelligent Ready mode on or off from the printer’s front panel:

1. With Menus highlighted, press the OK key.

2. Scroll to the Printer Setup Menu by pressing the Up Arrow or Down Arrow key.

3. Press the OK key.

4. Scroll to Intelligent Ready by pressing the Up Arrow or Down Arrow key. The 
end of the line also displays the setting (On or Off). 

5. To change the setting, press the OK key.

To select Intelligent Ready mode or schedule warmup/standby settings using 
CentreWare IS Printer Management software:

1. From your printer’s Internet Services home page, click Properties.

2. On the left side of the Properties page in CentreWare IS, click Warmup.

3. For Warmup Mode, select either Intelligent Ready or Scheduled (if you want to 
specify the warmup/standby settings for each day).

4. If you selected Scheduled in Step 3, make selections for each day’s warmup setting 
and standby setting.

5. Click the Save Changes button on the bottom of the page.

Note

Although the front panel selections only enable you to turn Intelligent Ready 
mode on or off, CentreWare IS enables you to specify other settings, such as the 
printer’s warm-up times.

Front panel language

To change the language used for the text on the front panel:

1. On the front panel, with Menus highlighted, press the OK key.

2. Scroll to the Printer Setup Menu by pressing the Up Arrow or Down Arrow key.

3. Press the OK key.

4. Scroll to Set Front Panel Language by pressing the Up Arrow or Down Arrow 
key.

5. Press the OK key.

6. Scroll the desired language by pressing the Up Arrow or Down Arrow key.

7. Press the OK key.

Note

You can also hold down the Cancel key and press the Info keys to display the 
Set Front Panel Language menu.
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Automatic tray switching

When your printer has a Lower Paper Tray assembly or a High Capacity Feeder, you can 
easily run large jobs without having to replace paper so often. The printer automatically 
takes paper from the next tray when the first tray runs out.

� For automatic tray switching to work properly, load the same type and size paper in 
all of the printer’s paper trays.

� In the printer driver, select Autoselect Tray (Windows 9x) or Automatically Select 
(Windows NT) as the source, instead of a specific tray.
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Printer Utilities
In addition to using the printer’s front panel or the options in a supported driver, the 
printer’s utility files offer another method for changing the way the printer operates.

Some utility files control print features, such as the default color correction. However, 
printer features that are selected from a printer driver override utility file settings as well 
as front panel settings.

Utility files are located on the:

� Printer’s CD-ROM

� Xerox web site

� Phaser hard drive

Utility files on the printer’s CD-ROM

Installing the utility files on a Macintosh

To install the Apple Printer Utility:

1. From the printer’s CD-ROM, run the Phaser Printer Installer application and select 
Easy Install.

2. In the PhaserTools folder on your computer’s hard disk, locate the Apple Printer 
Utility.

To install the printer’s utility files:

1. On the printer’s CD-ROM, open the English folder, open the Snippets folder, then 
open the Printer Utilities folder.

2. Copy the Printer Utilities folder or individual files to your computer’s hard disk.

To download a utility file from your Macintosh to the printer, see page 39.

Installing the utility files on a PC

To locate the printer’s utility files:

1. Insert the printer’s CD-ROM into the CD-ROM drive.

� If the Windows autorun feature is enabled, the CD-ROM launches automatically.  
On the opening screen, click Exit.

2. In the Windows Explorer, select the drive letter of your computer’s CD-ROM drive.

3. Locate the utility files on the CD-ROM by opening the Utility folder, then opening the 
Snippets folder, then opening the phsr7700 folder. 

Use the files on the CD-ROM or copy the files to your computer’s hard disk. To download 
a utility file from your PC to the printer, see page 41.
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Utility files on the Xerox web site   
On the Xerox Color Printer web site, you can explore options such as customer support, 
documents, and new product information. New and updated information is always being 
added, so check the web site frequently.

Access the Xerox Color Printer web site by entering the following address in a web 
browser: www.xerox.com/officeprinting/ 

To locate the utility files:

1. Start your web browser (such as Netscape Navigator or Internet Explorer).

2. Enter the following web address: 
www.xerox.com/officeprinting/support/software.html

3. From the pull-down lists, select your printer, computer platform, and Printer Utilities 
for the type of file.

4. Click the Go button to search the web site and display a list of files that you can 
download.

5. For each file that you want to download, click on the name of the file, select Save this 
file to disk, click the OK button, select the location to save the file, and click the Save 
button.

The requested file is downloaded to your computer. 
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Downloading utility files from a Macintosh   
Use the Apple Printer Utility to download files from your Macintosh to the printer.

To download PostScript utility files to the printer:

1. From the PhaserTools folder on your computer’s hard disk, double-click the Apple 
Printer Utility.  

2. In the Printer Selector dialog box:

a. Under AppleTalk Zones, select your printer’s zone.

b. Under Printers, select your Phaser 7700 Color Printer.

c. Click the Open Printer button.

3. From the File menu, select Send PostScript File.

4. In the Select the PostScript files to download dialog box, select the folder location of 
the PostScript file(s) that you want to download.

If you didn’t copy the files to your computer’s hard drive, use the CD-ROM; the utility 
files are located in the Printer Utilities folder inside the Phaser Tools folder.

5. Select a utility file and click Add to add the file to the list of files to download.

6. Repeat step 5 for all utility files that you want to download.

7. Click the Send button to download those files on the list.

8. In the lower portion of the dialog box for Save PostScript output as, either use the 
default name or type a new name for the file to be used for saving printer output. 
(Printer output includes status messages generated by the printer as it reports 
conditions such as out of paper.)

9. Click the Save button.

10. If no output is returned by the printer but the Apple Printer Utility displays a dialog 
box, click Continue. (If output is returned by the printer, you won't see this dialog 
box; check your computer’s hard disk for the message file created by the utility.)

You can download utility files to print a color sampler chart; refer to page 26 for more 
information about color sampler charts.

For information on downloading fonts from your Macintosh to the printer, refer to page 26; 
to print a list of fonts on the printer, refer to page 27.
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Using the Apple Printer Utility to perform other tasks

In addition to downloading PostScript files and fonts, you can use the Apple Printer Utility 
to perform the following specialized tasks:

� Turning on/off the Startup Page

� Changing the printer’s AppleTalk name

Note

If your printer is connected through a print server, you can only use the Apple 
Printer Utility to download PostScript utility files.

To turn on/off the Startup Page:

1. Double-click the Apple Printer Utility.

2. In the Printer Selector dialog box:

a. Under AppleTalk Zones, select your printer’s zone.

b. Under Printers, select your Phaser 7700 printer.

c. Click the Open Printer button.

3. In the printer’s dialog box, click the arrow next to Printer Preferences to display a list 
of options.

4. Click the arrow next to Startup Page.

5. Click to either place or remove the check mark from the box:

� Check mark:  Prints a Startup Page each time the printer is turned on or reset.

� No check mark:  Stops the Startup Page from automatically printing.

6. Click the Send button to update this printer option.

To change the printer’s AppleTalk name:

1. Double-click the Apple Printer Utility.

2. In the Printer Selector dialog box:

a. Under AppleTalk Zones, select your printer’s zone.

b. Under Printers, select your Phaser 7700 printer.

c. Click the Open Printer button.

3. In the printer’s dialog box, click the arrow next to Printer Preferences to display a list 
of options.

4. Click the arrow next to Name.

5. In the text box, type the new printer name. 

6. Click the Send button to update the printer name.
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Downloading utility files from a PC   

Downloading files from Windows 95/Windows 98/Windows Me 
1. Select the utility file you want to send to the printer, for example RESET.PS.

2. In the taskbar on your screen, click Start, then Programs, then MS-DOS Prompt.

3. Change the directory to the location of the utility files.

4. If your printer is connected to the parallel (LPT) port, type the following command 
(where x is 1, 2, or 3): 
COPY RESET.PS LPTx:

If your printer is connected to a network, refer to the "Downloading files if your 
printer is connected to a Novell NetWare network" section on this page.

Downloading files from Windows NT/Windows 2000
1. Select the utility file you want to send to the printer, for example RESET.PS.

2. In the taskbar on your screen, click Start, then Run, then type the following in the text 
box to access the MS-DOS Prompt.
COMMAND 

3. Change the directory to the location of the utility files.

4. If your printer is connected to the parallel (LPT) port, type the following command 
(where x is 1, 2, or 3):
COPY RESET.PS LPTx:

If your printer is connected to a network, type the following command:
lpr -S <IP Address> -P PS RESET.PS

Downloading files if your printer is connected to a Novell NetWare 
network

This procedure lets you redirect (capture) LPT ports in Novell NetWare. NetWare queues 
can be captured from the DOS Prompt or captured directly from Windows. To find out if 
an LPT port is already captured, type the following command from the DOS Prompt:         
capture show

This will list the current capture data for each virtual port.

Note

If an ad command or file name error occurs, run the command from the file 
servers Public directory.
Advanced Features and Troubleshooting Manual 41



Printer Utilities 
� For NetWare 3.xx and NetWare 4.xx bindery queues:

capture q=[queue_name] l=[port] nb nff nt

where queue_name is the name of the queue to be captured, and port is the virtual 
port to capture to, such as LPT3.

Also, nb is no banners, nff is no form feeds, and nt is no tabs.

For example: capture q=phaser_7700 l=3 nb nff nt

Note

For NetWare 4.xx NDS queues, the queue name needs to start with a period.
For example:
capture q=.phaser_860_q.nds.printers.support l=2 nb nff nt

For Windows 95 / 98 environments:

1. From the Details tab of your printer’s driver, select the Capture Printer Port button.

2. In the Capture Printer Port dialog box:

� For bindery queues, enter the path as \\server_name\queue_name
For example: \\nw_server\Phaser_7700

� For NDS queues, enter the path as \\Tree\queue_name.context
For example: \\Tek\.Phaser_7700_Q.nds.printers

3. Click the OK button.

Note

If the appropriate file server is not listed, click the Attach button and select the 
desired file server. Login and click the OK button. Within the Operation section, 
check the box next to Permanent, then click Connect. The port should then be 
captured.

Downloading files if your printer is connected to Windows NT

Use this procedure to redirect (capture) LPT Ports.

Under Windows NT print spooler, you create Ports based on their physical location: 

� Local ports = Lpt1 / Lpt2, etc.

� IPX Port = \\NW_SERVER\Phaser

� AppleTalk Ports = WV Net 36:Phaser

� TCP/IP Ports = 162.36.62.151:PS or [AUTO] 

However, if you’re at a command prompt (DOS Prompt) and want to print, or copy, a 
PostScript file to a port that is a network port, you can do the following:

� TCP/IP Ports:

lpr -S [printers IP Address] -P [print queue] filename

For example: lpr -S 134.62.36.70 -P PS test.ps
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� IPX and AppleTalk ports require the redefinition of the LPTX port to the network 
path through the use of the NET USE command.

NET USE LPT1 \\Server_Name\Queue_Name

For example: NET USE LPT1 \\NW_SERVER\Phaser
or: NET USE LPT2 \\NT_SERVER_NT\Phaser

After redirecting the port using the NET USE command you can use the COPY 
command to print the postscript file.

For example: C:\> COPY TEST.PS LPT1:

When finished, end the redirect with the command:

NET USE LPT1 /delete
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Troubleshooting Phaser 7700 Color 
Printers

Getting Help
Refer to the following resources for information about your printer:

� Printer CD-ROM

� Advanced Network Management Tools CD-ROM

� Printer’s front panel and internal pages

� Windows driver and driver help system

� Xerox web sites

� CentreWare IS

� PhaserSMART™

� Other online services

Printer CD-ROM 

The printer’s auto-running CD-ROM guides you to the various resources available for 
installing and learning more about your Phaser color printer.

� Read Me release notes

� Printer drivers 

� Driver installers (for Mac and Windows)

� Phaser 7700 Color Printer User Guide 

� Advanced Features and Troubleshooting Manual (this manual)

� Installation Guide

� How-to videos 

� Networking information

� Consumables instructions

� Repacking instructions

� Adobe Acrobat Reader (for reading the PDF files)

� Adobe Type Manager (ATM)

Advanced Network Management Tools CD-ROM

This CD-ROM contains network management tools, including CentreWare DP, Unix tools, 
and the Font Downloader application.
44 Phaser 7700 Color Printer



Troubleshooting Phaser 7700 Color Printers
Printer’s front panel and internal pages 

You can press the Information key at any time to get additional information about the 
message displayed on the front panel.

On the printer’s front panel, use the Printable Pages menu or the Support Menu to 
print internal pages that contain information about the printer configuration, supplies 
information, paper tips, etc.

Windows driver and driver help system 

If you are using Windows 95, Windows 98, Windows 2000, or Windows NT, install the 
driver from the Printer CD-ROM and access the printer driver to:

� Access interactive troubleshooting assistance from the Technical Support link 
on the Troubleshooting tab.

� Link to other relevant web sites from the Troubleshooting tab.

� View information about the printer features on the driver tabs by clicking the 
Help button on the tab.

� View troubleshooting information by clicking a Help button, then selecting the 
Troubleshooting Guide.

To access the Phaser 7700 Color Printer driver:

1. Click Start, select Settings, then click Printers.

2. In the Printers folder, right-click the icon for your Phaser 7700 Color Printer.

3. From the popup menu, select Properties.

PhaserSMART™

PhaserSMART™ is an automated, Internet-based, support system. You can access 
interactive troubleshooting by selecting:

� In the printer driver, the Technical Support link on the Troubleshooting Tab.

� In CentreWare IS, the Technical Support link, under the Support Links section 
on the Support tab.

Once activated, PhaserSMART launches your browser and uploads usage information 
from your printer. It uses a logic engine to analyze the usage data and propose a solution. If 
your problem is not resolved by this solution, PhaserSMART guides you to open a Service 
Request with Xerox Customer Support.

PhaserSMART requires that your printer has an IP address and that Information 
Forwarding is turned on in the printer.
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Xerox web sites 

www.xerox.com/officeprinting/

� Product and supplies information

� Downloading printer drivers

� Finding your local reseller

� Online documentation

www.xerox.com/officeprinting/infoSMART/ 

The infoSMART™ knowledge base is the same troubleshooting knowledge base used by 
Xerox Customer Support staff to provide the latest technical information on:

� Application issues

� Networking issues

� Printer errors

� Print-quality issues

� Troubleshooting

www.colorconnection.xerox.com/ 

This site helps you get the most from your color printer:

� Interactive tutorials, color printing templates, and helpful tips for using your 
printer and favorite software applications.

� Easy access to online technical support.

� Customized features to meet your individual needs.

CentreWare IS 

For information on CentreWare IS, refer to page 29.

Other online services 

To find a local reseller 

Subscribe to email update notices: www.colorconnection.xerox.com/

Technical Support: www.xerox.com/officeprinting/support

See www.xerox.com/officeprinting/contacts for the most updated 
information.

U. S. 
1-800-835-6100

Canada
1-877-662-9338

Outside U.S. and 
Canada
Contact your local 
Xerox office for a list of 
local resellers
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Indicator light problems  
Status indicator light is off

The printer is turned off, is not ready, is disabled, or has detected an error.

� Make sure that the printer is plugged in and turned on.

� Do not plug the printer’s power cord into a power strip; use a wall outlet.

Status indicator light is blinking green

� If the printer is receiving, processing, or printing a job, wait for the job to be 
completed or cancel the job.

� If you have entered the menu in the front panel, you can exit the menu.

� If the warm-up sequence has not finished, wait until the printer displays Ready to 
Print.

Status indicator light is blinking yellow

� The printer is still printing but there is a warning condition that needs user attention 
soon.

Status indicator light is blinking red

� The printer has stopped because it detected an error or condition that required user 
intervention, such as an open door or a paper jam. Correct the condition reported on 
the front panel (such as by closing the door or clearing the paper jam).

� Press the Information key to access more information on the error condition.

� Refer to the following pages for information about particular error conditions. For 
detailed information about jams, refer to the Phaser 7700 Color Printer User Guide.

Front panel menu  
When in a menu, the front panel returns to Ready to Print

� The front panel menu times out and returns to Ready to Print if no activity occurs 
in the menu system in 2 minutes. The calibration menus and the TCP/IP Address 
Menu do not return to Ready to Print. You will not be able to print until you exit 
these menus.

� If you want to re-enter the menu system, highlight Menus and press the OK key.

You can press the Information key at any time to get additional information about the 
message displayed on the front panel.
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Problems with automatic two-sided printing    
Output is single-sided

� Make sure that you have selected two-sided printing in the printer driver.

� Maker sure that your paper weight meets the following requirement: 64-105 g/m2 (17-28 lbs.).

Frequent jams with two-sided printing

� Paper weight must be between 75-105 g/m2 (20-28 lb. bond).

The second side of a two-sided print is upside-down

� Select the correct method for binding preference in the printer driver.

� Refer to the Phaser 7700 Color Printer User Guide for more information on two-sided 
printing and binding preference.

Letterhead paper prints on the wrong side or prints upside-down      

� Refer to the Phaser 7700 Color Printer User Guide for more information on two-sided 
printing and binding preference.

Problems printing on labels
Labels are printed on the wrong side   

� Make sure that the labels are loaded face-down in the Multi-Purpose Tray (MPT).

� Make sure that two-sided printing is not selected in the printer driver; you cannot 
print labels on two sides.

� Make sure that you have selected Labels as the Paper Type.

� Make sure you have selected Multi-Purpose Tray (MPT) in the printer driver.

� Do not use a sheet of labels if any of the labels are missing.

Printing labels from Microsoft Word

1. From the Tools menu, select Envelopes and Labels.

2. In the Envelopes and Labels dialog box, click the Labels tab. 

3. In the dialog box, click on the label icon.
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4. In the Label Options dialog box, select all of the following, depending on label size:

Letter-size:

a. Printer: Laser and Ink-jet

b. Label Products: Avery standard

c. Select the label size corresponding to the Xerox label media: 

Metric-size:

a. Printer: Laser and Ink-jet

b. Label Products: Avery A4 and A5 sizes

c. Select the label size corresponding to Xerox label media: 

5. Click the OK button to exit the Label Options dialog box.

6. Click the Print button.

Avery 
label sizes Xerox label media Xerox part 

number

5160 A/Letter (U. S.)  
8.5 x 11 in.

100 sheets / 30 labels per 
sheet (each 1 x 2-5/8 in.)

016-1695-00 

5164 A/Letter (U. S.)  
8.5 x 11 in.

100 sheets / 6 labels per 
sheet (each 3-1/3 x 4 in.)

016-1696-00

Avery 
label sizes Xerox label media Xerox part 

number

L7163 A4  (Metric Letter)
210 x 297 mm

100 sheets / 14 labels per 
sheet (each 38.1 x 99.1 mm)

016-1688-00

L7165 A4  (Metric Letter)
210 x 297 mm

100 sheets / 8 labels per 
sheet  (each 67.1 x 99.1 mm)

016-1689-00
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Print quality problems 
� Maintain a stable temperature and relative humidity for the printer. See Calibrate for 

Paper on page 52.

� Use only the paper recommended for this printer; see the Phaser 7700 Color Printer 
User Guide.

� Align the paper edge guides in the paper tray to fit the paper. 

� Protect the print cartridge from prolonged exposure to direct light.

� Print the Printer Diagnostics pages or refer to the Phaser 7700 Color Printer to help 
you troubleshoot the following print problems:

� Light Lines in one Colors — Thin, light or white lines appear in only one color.

� Incomplete Fusing — Toner appears to be pulled off print, or is easy to rub or 
scratch off.

� Repeating Defects — Marks or voids recur uniformly in only one color. Marks of 
any color or voids recur uniformly in all colors and/or in non-printed areas.

� Image Offset — Toner appears to have been pulled off the page and placed about 
84 mm (3.3 inches) across the page from where it should be.

� Printing is too light or too dark in all colors.

� Solid fills appear mottled or splotchy.

� Blacks appear blue.

� Colored or black lines/smudges streak all colors — black and/or colored areas 
appear on the page in all colors and/or in non-print areas.

� Color misregistration — Color has shifted outside the designated area or has been 
superimposed over another color.

� If your margins are incorrect on media that was fed from the Multi-Purpose 
Tray (MPT), ensure that the paper guides are correctly positioned. Refer to the 
labels on the Multi-Purpose Tray (MPT) for more information. 

To print the Print-Quality Diagnostic Pages:

1. On the front panel, scroll to the Support menu by pressing the Up or Down 
Arrow key.

2. Press the OK key.

3. Scroll to the Improve Print Quality? menu by pressing the Up or Down 
Arrow key.

4. Press the OK key.

5. Scroll to the Print Diagnostic Pages menu by pressing the Up or Down 
Arrow key.

6. Scroll to the page that you want to print by pressing the Up or Down Arrow key.

7. Press the OK key to print the pages.
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Prints have dull, faded colors

� When printing transparencies, only use Phaser 7700 transparency film, which has 
been specially formulated for use in this printer, and make sure that you have 
selected Transparency in the Paper Source field in the printer driver.

� Increase the print quality or try a different color correction. Refer to the Phaser 7700 
Color Printer User Guide or print the Diagnosing Print-Quality Problems page from 
the Printable Pages Menu for more information.

Prints in black-and-white instead of color

� In the printer driver, check if the TekColor Correction is set to Black and White; if it 
is, choose a different color correction. Refer to page 3 for more information.

� If using a Macintosh:

� Make sure that you are using the correct PPD file with the latest Apple 
LaserWriter printer driver, that supports color PostScript.

� In the Print dialog box, make sure that Color/Grayscale is selected. Some 
applications require special files to print in color. Make sure that these files are 
properly installed. For information, refer to the topics on the printer’s CD-ROM 
or the Xerox web site.

� If using a PC:

� Be sure to use the correct printer driver from the printer’s CD-ROM.

� Make sure the application you are using is set up to print in color. 

Blue colors look too purple

� If printed blue colors look too purple, print your document with the Vivid Color color 
correction. Refer to page 2 for more information.

Transparency print quality is poor

� Only use Phaser 7700 Color Printer transparency film, which has been specially 
formulated for use in this printer.

� Try setting sRGB Vivid as the color correction. Refer to page 3 for more information.

� Make sure that you have selected Transparency in the printer driver.

Print is wrinkled or rippled

� If your paper is smooth, glossy, or coated, try a different type of paper. Use only 
supported paper types.

� Use single-sided printing instead of double-sided printing.
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Calibrate for Paper

If you are not satisfied with the print quality on the paper that you are using, you can 
calibrate the Phaser 7700 Color Printer for the specific paper type that you are using. 
Calibrating paper can change your printer settings for a particular paper type under your 
specific humidity conditions. You must place the paper that you want to calibrate in your 
Multi-Purpose Tray (MPT). The paper type (Laser Paper, Heavy Paper, etc.) that you select 
for the Multi-Purpose Tray (MPT) is the type that you are calibrating. Once you have 
calibrated this paper type, it will be calibrated for all trays. Print the Calibrate for Paper 
page and follow the instructions to calibrate your paper:

Note

If you cancel the calibrating for paper procedure while printing, it changes the 
setting to that of the last page printed. The current setting is only maintained if 
the procedure is allowed to complete.

1. On the front panel, scroll to the Support menu by pressing the Up or Down Arrow 
key.

2. Press the OK key.

3. Select the Improve Print Quality? menu by pressing the Down or Up Arrow key.

4. Press the OK key.

5. Select the Calibrate for Paper Menu by pressing the Down or Up Arrow key.

6. Press the OK key.

7. Select the Print Calibrate for Paper Pages by pressing the Down or Up 
Arrow key.

8. Press the OK key to print the calibration reference pages.

Note

When you review your reference pages, use the page with the Transfer Setting  
closest to zero where there is no toner adherence problem.

Printing problems 
The printer times out when connected to a parallel port

� Windows users: To change the timeout for transmission retry, refer to the Microsoft 
Online Help for instructions.

Part of the image is missing or the image is clipped

� For more details on page sizes, print areas, and margins, refer to the Phaser 7700 
Color Printer User Guide. To maximize the image area, you may have to adjust the 
margins in your application software.

� In your application, check the setting for Image Size.

� Make sure you have selected the correct paper size in the printer driver. 
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� Make sure you have selected Page Setup after changing printers.

� Ensure that the Multi-Purpose Tray (MPT) guides and the paper tray guides are 
correctly set.

Problems printing from a specific application

� Get information and tips on printing from specific applications (such as QuarkXPress 
and PageMaker) from the Xerox web site. Refer to page 46 for more information.

Fonts print incorrectly in Windows

� If you have downloaded fonts to your printer, or stored additional fonts on the 
internal hard drive, you may need to reinstall the fonts.

� If you are using PostScript fonts, make sure ATM (Adobe Type Manager) is installed 
and configured properly. ATM software is shipped with your printer.

Text prints in Courier font

� The font you have specified is not available so the printer substituted the Courier 
font. The printer has 136 resident fonts. Other fonts must be set up from the printer 
driver to print with each job.
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Preventing media jams      
Use the following guidelines to prevent media jams inside the printer.

� Make sure the printer is on a flat, level surface.

� Do not add media above the tray’s fill line.

� Ensure that the paper guides are tight against the stack of paper in the trays or the 
Multi-Purpose Trays (MPT)

� Media: 

� Use only the recommended media. Refer to the Phaser 7700 Color Printer User 
Guide or print the Paper Tips Page from the printer’s front panel.

� For transparencies, only use Phaser 7700 transparency film, which has been 
specially formulated for use in this printer.

� Use clean, undamaged paper. Keep paper and other supplies clean and free from 
dust. Paper that has been sitting out of its sealed wrapper can become distorted, 
causing paper jams. Keep paper sealed until you are ready to use it for printing.

� Do not use paper that has been creased or wrinkled.

� If paper is still jamming, flip the paper over in the paper tray

� Do not print on sheets of labels that are missing labels.

� Use only Phaser 7700 Color Printer Labels. 

� Do not use perforated paper, or odd-sized paper.

� For three-holed paper, make sure margins are adjusted to avoid printing over the 
holes.

� In high-humidity conditions, or when using speciality papers that can be printed on 
both sides: Remove the paper from the paper tray, turn over the stack of paper, and 
reinsert the paper into the tray. 
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Calibrate Margins
You can print a calibration reference page to evaluate if left and right margins need to be 
adjusted and by how much. Print the Calibrate Margins page and follow the instructions to 
calibrate your margins.

1. On the front panel, scroll to the Support menu by pressing the Up or Down Arrow 
key.

2. Press the OK key.

3. Select the Improve Print Quality? menu by pressing the Down or Up Arrow key.

4. Press the OK key.

5. Select the Calibrate Margins Menu by pressing the Down or Up Arrow key.

6. Press the OK key.

7. Select the Print Calibrate Margins Page by pressing the Down or Up Arrow 
key.

8. Press the OK key to print the calibration page.

Note

If the Calibrate Margins Page is printed on duplexable media, instructions for 
adjusting Side 2 margins are printed on the page and Side 2 is marked with 
dashed lines.

Restore factory defaults

You can reset margin settings to the factory-default values.

Caution

Use caution when resetting your margin settings to the factory-default settings. 
Changing these settings back to factory defaults may not be the last-saved settings 
if you have previously calibrated your margins. 

1. On the front panel, scroll to the Support menu by pressing the Up or Down Arrow 
key.

2. Press the OK key.

3. Select the Improve Print Quality? menu by pressing the Down or Up Arrow key.

4. Press the OK key.

5. Select the Calibrate Margins Menu by pressing the Down or Up Arrow key.

6. Press the OK key.

7. Select the Restore Factory Defaults by pressing the Down or Up Arrow key.

8. Press the OK key.
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Specifications for the 
Phaser 7700 Color Printer
Temperature

Operating: 10 degrees C to 32 degrees C (50 degrees F to 90 degrees F)

Non-operating: -30
 
degrees C to +50

 
degrees C (-22

 
degrees F to 122 degrees F)

Humidity

Operating: 10% to 85% relative humidity, non-condensing

Non-operating: 30% to 85% relative humidity, non-condensing

Altitude

Operating: 0 to 2,500 m (0 to 8,000 ft.) above sea level 

Shipping: 0 to 6,092 m (0 to 20,000 ft.) above sea level

Primary voltage ranges

110 - 127 VAC, 110 VAC nominal

220 - 240 VAC, 220 VAC nominal

Frequency range

50/60 Hz

Primary fusing

110-127 VAC, 220-240 VAC, 12 Amps and 5 Amps (Not user-accessible)

Power Consumption  

Dimensions of the printer (without a High-Capacity Paper Tray Assembly)

Depth: 682 mm (26.9 in.)

Width: 644 mm (25.4 in.)

Height: 493 mm (19.4 in.)

Weight of the printer

82 kg (180 lb.)

State Average Power Maximum Allowable

Warming up 500 Watts N/A

Continuous printing 500 Watts N/A

Standby 130 Watts N/A

ENERGY STAR® (optional) 45 Watts 70 Watts
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Dimensions of the printer with the optional Lower Tray Assembly

Height: 857 mm (33.7 in.)

Depth: 682 mm (26.9 in.)

Width: 644 mm (25.4 in.)

Sound level

Sound Power (LwAd) 

Printing: LWAd = 6.9 Bels (A) 
LwAd = 6.9 Bels (A) 

Standby: LwAd = 4.4 Bels (A)
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Regulatory Information for 
Phaser 7700 Color Printers
The equipment described in this manual generates and uses radio frequency energy. If it is 
not installed properly in strict accordance with Xerox's instructions, it may cause 
interference with radio and television reception or may not function properly due to 
interference from another device. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or more of the following 
measures:

� Reorient or relocate the receiver (device being interfered with).

� Increase the separation between the printer and the receiver.

� Connect the printer into an outlet on a circuit different from that which the receiver is 
connected.

� Route the interface cables on the printer away from the receiver

� Consult the dealer, Xerox service, or an experienced radio/television technician for 
help.

Changes or modifications not expressly approved by Xerox can affect the emission and 
immunity compliance and could void the user's authority to operate this product. To 
ensure compliance, use shielded interface cables. A shielded parallel cable can be 
purchased directly from Xerox at www.xerox.com.

Xerox has tested this product to internationally accepted electromagnetic emission and 
immunity standards. These standards are designed to mitigate interference caused or 
received by this product in a normal office environment.   This product is also suitable for 
use in a residential environment based on the levels tested. 

In the United States this product complies with the requirements of an unintentional 
radiator in part 15 of the FCC rules. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference; (2) this device must accept any 
interference received, including interference that may cause undesired operation.

This digital apparatus does not exceed the Class B limits for radio noise emissions from 
digital apparatus set out in the Radio Interference Regulations of the Canadian Department 
of Communications, ICES-003.

Le présent appareil numérique n'émet pas de bruits radioélectrique dépassant les limits 
applicables aux appareils numériques de la classe B prescrites dans le Réglement sur le 
brouillage radioélectrique édicté par le ministere des Communications du Canada, 
ICES-003.
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Xerox Corporation, declares, under our sole responsibility that the Phaser 7700 color laser 
printer (Z7700) to which this declaration relates, is in conformity with the following 
standards and other normative documents:

In the European Union;

following the provisions of the Low Voltage Directive 73/23/EEC and its amendments:  

following the provisions of the Electromagnetic Compatibility Directive 89/336/EEC and 
its amendments:

This product, if used properly in accordance with the user's instructions is neither 
dangerous for the consumer nor for the environment.

A copy of the signed Declaration of Conformity for this product can be obtained from 
Xerox.

EN 60950 (IEC 950) "Safety of Information Technology Equipment including Electrical 
Business Equipment"

EN55022:1998

(CISPR 22)

"Limits and Methods of measurement of radio interference 
characteristics of Information Technology Equipment." Class B.

EN61000-3-2;1995

:+A!:1998:+A2:1998.

(IEC61000-3-2)

"Part 3: Limits - Section 2: Limits for harmonic current emissions 
(equipment input current ≤ 16A per phase)."

EN61000-3-3:1995

(IEC61000-3-3)

"Part 3: Limits - Section 3: Limitation of voltage fluctuations and flicker 
in low-voltage supply systems for equipment with rated current ≤ 16A."

EN55024;1998

 (CISPR 24)

"Information technology equipment - Immunity characteristics - Limits 
and methods of measurement. "

CISPR 24 Immunity Phenomena Basic Standard Test Specification

Electrostatic Discharge IEC61000-4-2:1995 6kV Contact, 10kV Air

Radio-Frequency Electromagnetic 
Field (radiated)

IEC61000-4-3:1995 80-1000 MHz, 3V/m 

Fast Burst Transients IEC61000-4-4:1995 5/50 Tr/Th ns 5kHz Rep. Freq

     0.5kV on Signal Lines 

     1kV on AC Mains

Line Surge            IEC61000-4-5;1995 Combination wave

   2.0kV Common mode

   2.0kV Differentia mode

Radio-Frequency Electromagnetic 
Field (Conducted)

IEC61000-4-6;1996 0.15 - 80 MHz 3V, 80% AM @ 1kHz

 Line voltage dips IEC61000-4-11;1994 >95% dip for ½ cycle @ 50 Hz 

 40% dip for 5 cycles @ 50 Hz 

 70% dip for 25 cycles @ 50 Hz 

Line voltage drop-out IEC61000-4-11;1994 >95% dropout for 250 cycles @ 50 Hz
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A
Adobe Photoshop plug-in 20
altitude, operating range 56
Automatic color correction 3
automatic tray switching 36

B
Black and White color correction 3
black density

adjusting 18
booklet

printing 7

C
CD-ROM for printer 44
CentreWare IS 46
CentreWare IS Printer Management 
software 29
CMYK Sampler

Macintosh utility file 14
PC utility file 14

color
adjusting balance 18

color calibration 18
color charts

CMYK 12
HSB 12
PANTONE Color 15
printing from a Macintosh 14
printing from a PC 14
printing from the front panel 12
RGB 12

color connection 46
color corrections 3
color density

adjusting 18
Commercial Press color correction 3

D
declaration of conformity 59
DIC color correction 3
downloading files from servers

World Wide Web 38
downloading files to the printer

Macintosh 39
PC 41
Windows 95 41

downloading fonts 25
Macintosh 26
PC 27

drivers
location 44
uses 45

duplex
troubleshooting 48

E
enabling and disabling the Startup Page 32
energy saving mode 34
Enhanced print quality mode 2
Euroscale Press color correction 3

F
features of the printer 1
Font Sampler, Macintosh utility file 14, 27
fonts

downloading 25
printing a list of resident fonts 27
sampler, printing 27
TrueType 25

FONTS.PS, PC utility file 14, 28
frequency range 56
front panel

information key 45
light intensity 34
menus 33
messages, troubleshooting 47

H
Help button in printer driver 45
HSB Sampler

Macintosh utility file 14
PC utility file 14

I
information key 45
information pages 45
infoSMART 46
Intelligent Ready

short overview 34

L
labels

printing on wrong side 48
letterhead paper

printing on wrong side 48
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M
Macintosh utility files 39

color samplers 14
Font Sampler 14, 27
Menu Long 33
Menu Short 33

manuals 44
margins

calibrate 55
media jams

output after clearing 54
preventing 54

Menu Long, Macintosh utility file 33
Menu Short, Macintosh utility file 33
MENULONG.PS, PC utility file 33
MENUSHRT.PS, PC utility file 33
modes

print quality 2

N
None color correction 3

P
PANTONE Colors

installing printer files 16
printer-specific colors 15
printing the color chart from a 

Macintosh 16
printing the color chart from a PC 17
selection books 15

PC utility files
color samplers 14
FONTS.PS 14, 28
MENULONG.PS 33
MENUSHRT.PS 33

PhaserPrint plug-in
compatibility requirements 20
for Photoshop 20
installing for Macintosh 20
starting the plug-in 20

Photoshop plug-in 20
Plug-in, Adobe Photoshop, using 20
power consumption specifications 56
primary fusing 56
primary voltage ranges 56
print features

automatic tray switching 36
controlling through CentreWare IS 29

print quality
calibrate for paper type 52

print quality modes 2

print quality problems
troubleshooting 52

printer
dimensions 56
front panel menus 33
quality modes 2

printer CD-ROM contents 44
printer drivers

location 44
uses 45

proof prints 4

Q
quality modes 2

R
regulatory standards 58
resellers 46
RGB Sampler

Macintosh utility file 14
PC utility file 14

S
saved prints 4
secure prints 4
separation pages 6
setting

front panel intensity 34
SNAP Press color correction 3
specifications 56
sRGB Display color correction 3
Standard print quality mode 2
standby mode 34
Startup Page

enable or disable 32
SWOP Press color correction 3
Sys/Start Job, enable or disable 34

T
TekColor color corrections 3
Toyo color correction 3
transparencies

print quality modes 2
tray switching 36
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troubleshooting
black and white prints instead of 

color 51
duplex 48
front panel messages 47
labels are printed on wrong side 48
labels printing on wrong side 48
letterhead paper printing on wrong 

side 48
paper jams, preventing 54
print quality problems 52
printed colors 50
two-sided printing 48

TrueType fonts 25
two-sided printing

troubleshooting 48

U
Usage Profile reports

brief overview 30
utility files

Macintosh, using 39
PC, using 41

V
videos 44
Vivid Color color correction 3
voltage ranges 56

W
watermark 9
web sites 46
World Wide Web

downloading files from 38

X
Xerox web sites 46
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